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GE Fanuc Automation 

Series 90-30/70  

Computer Link Driver 
 Supported version TOP Design Studio V1.0 or higher  

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 
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1. System configuration 

The system configuration of TOP and “GE Fanuc Intelligent Platforms, Inc. – Series 90-30/70, VersaMax(Nano/Micro)” is as follows. 

 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

Series 

90–30 

PLC 

IC693CPU311 

IC693CPU313 

IC693CPU321 

IC693CPU323 

IC693CPU331 

IC693CPU340 

IC693CPU341 

IC693CPU350  

IC693CPU351  

IC693CPU352  

IC693CPU360  

IC693CPU363  

IC693CPU364  

IC693CPU374  

IC693CPU311  

IC693CPU313  

IC693CPU323  

IC693CPU331  

IC693CPU340 

SNP Serial Port 

on Power unit 

RS–422 

(4 wire) 

3. TOP communication 

setting 

4.1. External device setting 1 

5.1. Cable table 1 

IC693CPU311  

IC693CPU313  

IC693CPU321  

IC693CPU323  

IC693CPU331  

IC693CPU340  

IC693CPU341  

IC693CPU350  

IC693CPU360  

IC693CPU364 

Built-in Serial Port 
RS–422 

(4 wire) 

3. TOP communication 

setting 

4.1. External device setting 1 

5.1. Cable table 1 

IC693CMM311 

RS-232C 
3. TOP communication 

setting 

4.3 External device setting 3 

5.2. Cable table 2 

RS–422 

(4 wire) 

IC693CPU351  

IC693CPU352 

IC693CPU363 

Built-in Serial Port 
RS–422 

(4 wire) 

3. TOP communication 

setting 

4.1. External device setting 1 

5.1. Cable table 1 

Port 1  

on CPU Unit 
RS-232C 3. TOP communication 

setting 

4.2. External device setting 2 

5.1. Cable table 1 
Port 2 

on CPU Unit 

RS–422 

(4 wire) 

IC693CMM311 

RS-232C 

 
3. TOP communication 

setting 

4.3 External device setting 3 

5.2. Cable table 2 
RS–422 

(4 wire) 

IC693CPU374 

Port  

on Power unit 

RS–422 

(4 wire) 

3. TOP communication 

setting 

4.1. External device setting 1 

5.1. Cable table 1 

IC693CMM311 

RS-232C 

 
3. TOP communication 

setting 

4.3 External device setting 3 

5.2. Cable table 2 
RS–422 

(4 wire) 

☞Continued on the next page.
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Series CPU Link I/F 
Communication 

method 
System setting Cable 

Series 

90–70 

PLC 

IC697CPU731  

IC697CPU771  

IC697CPU772  

IC697CPU780  

IC697CPU781  

IC697CPU782  

IC697CPU788  

IC697CPU789  

IC697CPM790  

IC697CPM915  

IC697CPM925  

IC697CPX722  

IC697CPX782  

IC697CPX928  

IC697CPX935  

IC697CGR772  

IC697CGR935  

IC697CSE784  

IC697CSE924  

IC697CSE925 

SNP Serial Port 

on CPU unit 

RS–422 

(4 wire) 

3. TOP communication 

setting 

4.1. External device 

setting 1 

5.1. Cable table 1 

IC697CPU731  

IC697CPU732  

IC697CPU771  

IC697CPU772  

IC697CPU781  

IC697CPU782  

IC697CPU788  

IC697CPU789  

IC697CPM790  

IC697CPM914  

IC697CPM915  

IC697CPM924  

IC697CPM925  

IC697CPX772  

IC697CPX782  

IC697CPX928  

IC697CPX935  

IC697CGR772  

IC697CGR935 

IC697CMM711 

RS-232C 

 

3. TOP communication 

setting 

4.3 External device 

setting 3 

5.2. Cable table 2 

RS–422 

(4 wire) 

VersaMax 

(Nano/Micro) 

PLC 

IC200C□□□□□ 

IC200N□□□□□ 

IC200U□□□□□ 

Port 1  

on CPU unit 
RS-232C 

3. TOP communication 

setting 

4.4. External device 

setting 4 

5.3. Cable table 3 
Port 2  

on CPU unit 

RS–422 

(4 wire) 

 

■ Connection configuration 

ㆍ1:1 (one TOP and one external device) connection – configuration which is possible in RS232C/422 communication. 

 
 

ㆍ1:N (one TOP and multiple external devices) connection – configuration which is possible in RS422 communication. 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “GE Fanuc Automation”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

Series 90-30/70 Computer Link Set Users 
 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 

Supported Protocol 

SNP SNP-X 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project properties > TOP settings] → [Project option > Check “Use HMI settings” > Edit > Serial ] 

– Set the TOP communication interface in TOP Design Studio. 
 

 

 

 
 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 

RS-232C 

RS-422 
 

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Project > Project properties > PLC settings > COM > “PLC1 : Series90-30/70”] 

– Set the options of the communication driver of Series90-30/70 Computer Link (SNP/SNP-X) in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select the serial communication protocol between the TOP and an external device. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

SNP ID Enter SNP ID for external device.  
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 

RS-232C 

RS-422 
 

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

  

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select the serial communication protocol between the TOP and an external device. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

SNP ID Enter SNP ID for external device. (Configure with TOP Design Studio)  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 
 

4.1 External device setting 1 (Port on Power Unit, Built in Serial Port of Series 90-30/70) 

Use “90–30/70 Series” Ladder Software “CIMPLICITY Machine Edition” to set as follows. Reboot the external device after 

downloading the settings. For more detailed setting method than described in this example, refer to PLC user manual.   

 

Step 1. Add the PLC Series you want to use as “Target” through the “[Project] – [Add Target] – [GE Fanuc Controller]” path of the 

Tool Bar. 

 

Step 2. Add the “Power” and “CPU Module” to the “[Hardware Configuration] – [Main Rack]” path. 

 

Step 3. Select the communication method between PC and PLC in the [Properties] of the “Target”, and then execute [Target] – [Go 

Online with “Target”] in the Tool Bar to connect to PLC. 
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Step 3. Double-click “CPU Module” to display the setting window, and in the [Settings] of the window, set as follows. 

 

 

Items Contents Settings Remarks 

Data Rate[bps] Set the serial communication speed of an external device. 19200  

Parity Set the serial communication parity bit of an external device. None  

Stop Bits Set the serial communication stop bit of an external device. 1  

SNP ID Set the SNP ID of the external device. 0  

 

Step 4. Execute [Target] – [Download “Target” to Controller…] in the Tool Bar to download the settings to PLC. 
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4.2 External device setting 2 (Port 1/2 on CPU Unit of Series 90-30/70) 

Use “90–30/70 Series” Ladder Software “CIMPLICITY Machine Edition” to set as follows. Reboot the external device after 

downloading the settings. For more detailed setting method than described in this example, refer to PLC user manual.  
 

Step 1. Add the PLC Series you want to use as “Target” through the “[Project] – [Add Target] – [GE Fanuc Controller]” path of the 

Tool Bar. 

 

Step 2. Add the “Power” and “CPU Module” to the “[Hardware Configuration] – [Main Rack]” path. 

 

Step 3. Select the communication method between PC and PLC in the [Properties] of the “Target”, and then execute [Target] – [Go 

Online with “Target”] in the Tool Bar to connect to PLC. 
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Step 3. Double-click “CPU Module” to display the setting window, and in the [Port1 (RS-232)] or [Port2 (RS-485)] tab of the 

window, set as follows. 

 

 

Items Contents Settings Remarks 

Port Mode Set the serial communication protocol of the corresponding port. SNP Fixed 

Port Type Set the serial communication mode of the corresponding port. Slave Fixed 

Data Rate[bps] Set the serial communication speed of an external device. 19200 Set Users 

Parity Set the serial communication parity bit of an external device. None  

Stop Bits Set the serial communication stop bit of an external device. 1  

SNP ID Set the SNP ID of the external device. 0  

 

Step 4. Execute [Target] – [Download “Target” to Controller…] in the Tool Bar to download the settings to PLC. 
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4.3 External device setting 3 (IC693CMM311, IC697CMM711) 

Use “90–30/70 Series” Ladder Software “CIMPLICITY Machine Edition” to set as follows. Reboot the external device after 

downloading the settings. For more detailed setting method than described in this example, refer to PLC user manual.  

Step 1. Add the PLC Series you want to use as “Target” through the “[Project] – [Add Target] – [GE Fanuc Controller]” path of the 

Tool Bar. 

 

Step 2. Add the “Power”, “CPU Module”, and “link I/F Module” to the “[Hardware Configuration] – [Main Rack]” path. 

 

Step 3. Select the communication method between PC and PLC in the [Properties] of the “Target”, and then execute [Target] – [Go 

Online with “Target”] in the Tool Bar to connect to PLC. 
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Step 3. Double-click ”link I/F Module” to display the setting window, and in the [Port1] or [Port2] tab of the window, set as follows. 

 
 

Setting items Contents Settings Remarks 

Configuration Mode Set the serial communication protocol of the Link I/F Module. SNP Only Fixed 

 

Port 1 item Contents Settings Remarks 

SNP Enable Set whether to communicate with SNP. Yes Fixed 

SNP Mode Set the SNP communication mode. Slave Fixed 

Data Rate (bps) Set the serial communication speed of Link I/F Module. 19200  

Parity Set the serial parity bit of Link I/F Module. None  

Stop Bit Set the serial stop bit of Link I/F Module. 1  

 

 Port 2 item Contents Settings Remarks 

SNP Enable Set whether to communicate with SNP. Yes Fixed 

SNP Mode Set the SNP communication mode. Slave Fixed 

Data Rate (bps) Set the serial communication speed of Link I/F Module. 19200  

Interface Set the serial communication interface of Link I/F Module. RS485  

Parity Set the serial parity bit of Link I/F Module. None  

Stop Bit Set the serial stop bit of Link I/F Module. 1  

 

※ Set the “SNP ID” among [CPU module] - [Settings] parameter items. 

 

Step 4. Execute [Target] – [Download “Target” to Controller…] in the Tool Bar to download the settings to PLC. 
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4.4 External device setting 4 (Port 1/2 on CPU Unit of VersaMax) 

Use “90–30/70 Series” Ladder Software “CIMPLICITY Machine Edition” to set as follows. Reboot the external device after 

downloading the settings. For more detailed setting method than described in this example, refer to PLC user manual.   

 

Step 1. Add the PLC Series you want to use as “Target” through the “[Project] – [Add Target] – [GE Fanuc Controller]” path of the 

Tool Bar. 

 

Step 2. Add the “Power” and “CPU Module” to the “[Hardware Configuration] – [Main Rack]” path. 

 

Step 3. Select the communication method between PC and PLC in the [Properties] of the “Target”, and then execute [Target] – [Go 

Online with “Target”] in the Tool Bar to connect to PLC. 
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Step 3. Double-click “CPU Module” to display the setting window, and in the [Port1 (RS-232)] or [Port2 (RS-485)] tab of the 

window, set as follows. 

 

 

Items Contents Settings Remarks 

Port Mode Set the serial communication protocol of the corresponding port. SNP Fixed 

Port Type Set the serial communication mode of the corresponding port. Slave Fixed 

Data Rate[bps] Set the serial communication speed of an external device. 19200  

Parity Set the serial communication parity bit of an external device. None  

Stop Bits Set the serial communication stop bit of an external device. 1  

SNP ID Set the SNP ID of the external device. 0  

 

Step 4. Execute [Target] – [Download “Target” to Controller…] in the Tool Bar to download the settings to PLC. 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “GE Fanuc Automation”.) 
 

5.1 Cable table 1 (Port on Power Unit, Built-in Serial Port of Series 90-30/70) 

 

■ RS-422 (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  13 SDA 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin male 

(male, convex) 

 2 12 SDB 

 3 11 RDA 

RDB 4 10 RDB 

SG 5 7 SG 

SDA 6 6 RTS+ 

 7 15 CTS+ 

 8 14 RTS– 

SDB 9 8 CTS– 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-232C (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 CTS 

 

Based on 

communication 

cable connector 

front, 

6 pin male RJ12 

(male, convex) 

RD 2 2 TXD 

SD 3 3 0V 

DTR 4 4 SG 

SG 5 5 RXD 

DSR 6 6 RTS 

RTS 7  

CTS 8 

 

9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

 

■ RS-422  (1:N connection) – Refer to 1:1 connection to connect in the following way. 

TOP Cable connection and signal 

direction 

PLC Cable connection and signal 

direction 

Terminating PLC 

Signal name Signal name Signal name 

RDA  SDA  SDA 

RDB SDB SDB 

SDA RDA RDA 

SDB RDB RDB 

SG 0V 0V 

 

 RTS+  RTS+ 

 CTS+  CTS+ 

 RTS–  RTS– 

 CTS–  CTS– 
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5.2 Cable table 2 (ICM693CMM311, ICM697CMM711) 

 

■ RS-232C (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1  

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin male 

(male, convex) 

RD 2 2 TD 

SD 3 3 RD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6  

RTS 7 7 SG 

CTS 8 
(Omitted) 

 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  21 SDA 

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin male 

(male, convex) 

 2 9 SDB 

 3 25 RDA 

RDB 4 13 RDB 

 5 7 SG 

SDA 6 10 RTS+ 

 7 11 CTS+ 

 8 22 RTS– 

SDB 9 23 CTS– 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

 

■ RS-422  (1:N connection) – Refer to 1:1 connection to connect in the following way. 

TOP Cable connection and signal 

direction 

PLC Cable connection and signal 

direction 

Terminating PLC 

Signal name Signal name Signal name 

RDA  SDA  SDA 

RDB SDB SDB 

SDA RDA RDA 

SDB RDB RDB 

SG 0V 0V 

 

 RTS+  RTS+ 

 CTS+  CTS+ 

 RTS–  RTS– 

 CTS–  CTS– 
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5.3 Cable table 3 (Port on CPU Unit of VersaMax) 

 

■ RS-232C (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 RTS 

 

Based on 

communication 

cable connector 

front, 

8-pin male RJ45  

(Male, convex) 

RD 2 2 CTS 

SD 3 3 RXD 

DTR 4 4 TXD 

SG 5 5  

DSR 6 6  

RTS 7 7  

CTS 8 8 GND 

 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  13 SDA 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin male 

(male, convex) 

 2 12 SDB 

 3 11 RDA 

RDB 4 10 RDB 

 5 7 SG 

SDA 6 6 RTS+ 

 7 15 CTS+ 

 8 14 RTS– 

SDB 9 8 CTS– 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422  (1:N connection) – Refer to 1:1 connection to connect in the following way. 

TOP Cable connection and signal 

direction 

PLC Cable connection and signal 

direction 

Terminating PLC 

Signal name Signal name Signal name 

RDA  SDA  SDA 

RDB SDB SDB 

SDA RDA RDA 

SDB RDB RDB 

SG 0V 0V 

 

 RTS+  RTS+ 

 CTS+  CTS+ 

 RTS–  RTS– 

 CTS–  CTS– 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

Device Bit Address Word Address Word Address NOTE 32 BIT 

Input Relay I00001 – I32768 I00001 – I32753 I00001 + 16*n *Note 1) 

L/H*Note 2) 

Output Relay Q00001 – Q32768 Q00001 – Q32753 Q00001 + 16*n *Note 1) 

Internal Relay M00001 – M32768 M00001 – M32753 M00001 + 16*n *Note 1) 

Global Relay G0001 – G7680 G0001 – G7665 G0001 + 16*n *Note 1) 

Momentary Relay T001 – T1024 T001 – T1009 T001 + 16*n *Note 1) 

System Function Relay 

S001 – S128 

SA001 – SA128 

SB001 – SB128 

SC001 – SC128 

S001 – S113 

SA001 – SA113 

SB001 – SB113 

SC001 – SC113 

S001 + 16*n *Note 1) 

Register R00001.0 – R32640.15 R00001 – R32640  

Analog Input AI0001.0 – AI32640.15 AI0001 – AI32640  

Analog Output AQ0001.0 – AQ32640.15 AQ0001 – AQ32640  

*Note 1) When using a bit address that uses decimals, use a word address in units of “16” 

*Note 2) The lower 16-bit data of 32-bit data is saved in the screen-registered address, and the upper 16-bit data is saved in the 

address following the screen-registered address. 

   Ex. When saving 32BIT data hexadecimal data 12345678 in address D00100, it is saved to 16BIT device address as follows: 

Items 32BIT 16BIT 

Address D00100 D00100 D00101 

Input data 

(hexadecimal) 
12345678 5678 1234 

 


